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1 Description

Server Board Features

The SE7500W V2 is available in either SCSI or ATA hard drive interface versions as described in
Table 1. The features listed in Table 2 are common to both server board versions.

Table 1. Server Board Versions

Feature Description
SCSI Dual channel Ultra160 LVD SCSI accessible at rear panel I/O and internally
ATA Dual channel ATA 100 RAID

&= NOTE

The feature set listed in Table 2 only reflects usage with either the 1U
Intel® SR1300 or the 2U Intel® SR2300 server chassis. Third-party or OEM
chassis may not provide all of the features listed below.

Table 2. Server Board Features

Feature Description

Processors Dual processor slots supporting Intel® Xeon™ processors in an INT3/FCPGA Socket
604 package.

Memory Six dual inline memory module (DIMM) slots support:
e DDR-200 or DDR-266 compliant, ECC, registered, 72-bit, 168-pin, DIMMs
e From 256MB to 12 GB of memory

Graphics Integrated onboard ATI RAGET XL PCI SVGA controller.
Video Memory | 8 MB SDRAM of video memory.
PCI bus Two PCl riser slots capable of supporting either of the following configurations:

¢ 1U configuration-one full-length, full-height 64-bit PCI riser slot and one Low Profile
(LP) 64-bit PCl riser slot.

¢ 2U configuration-three full-length, full-height 64-bit PCI riser slots and three LP 64-bit
PClI riser slots.

Network Dual on-board 10/100/1000 Network Interface Controllers (NIC).

System 1/0 One PS/2T keyboard/mouse port (6 pin DIN).

(See Table 1) One VGA video port (15 pin).

Two external USB ports, internal header providing two additional USB.
One external serial port (RJ-45), one internal COM 1 header.

One external SCSI port (SCSI server board only), one internal.

Two NIC ports (RJ-45).

Form Factor Server ATX form factor.




Server Board Connector and Component Locations
The SE7500WV2 comes in both SCSI and ATA versions. Figure 1 is a composite view of both

versions.
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A. System status LED P. Auxiliary signal connector
B. IDLED Q. Sys fan 1 connector
C. Diagnostic LEDs (POST code) R. Sys fan 2 connector
D. 64-bit PCl riser slot for PCI-X bus B (full height) S. Main power connector
E. DIMM slots T. Battery
F. 1/0O ports U. Power supply signal connector
G. SCSI channel B connector (SCSI version only) V. ATX front panel connector
H. COM 1 serial header W. SSI front panel connector
I.  ICMB connector X. Floppy/FP/IDE connector
J.  IPMB connector Y. ATA/IDE connector
K. 64-bit PCl riser slot for PCI-X bus C (low profile)  Z. Floppy drive connector
L. Secondary processor socket AA. USB 2 & 3 header
M. Secondary processor fan connector BB. ATA-100 connectors (ATA version only)
N. Primary processor socket CC. Hard Disk Drive LED header
O. Primary processor fan connector DD. Speaker

Figure 1. Server Board Connector and Component Locations
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Back Panel Connectors

OM14125

USB 0 connector

Video connector

SCSI channel A connector (SCSI server board only)
NIC 2 RJ-45 connector

Status LED

Speed LED

NIC 1 RJ-45 connector

Status LED

Speed LED

PS/2 keyboard/mouse connector
RJ-45 serial port

. USB 1 connector

Figure 2. Back Panel Connectors
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Processor

The SE7500W V2 accommodates one or two Intel Xeon processors with 512k cache in the
INT3/FCPGA Socket 604 package. This processor uses the .13 micron technology. Check the
Intel Customer Support website for the latest list of supported processors see:

http://support.intel.com/

Memory

The system board has six 168-pin DIMM slots each supporting 72-bit ECC registered DDR
DIMMs (DDR-200 or DDR-266 compatible). Memory is partitioned in three banks. You may
install a minimum of 256 MB (128MB x 2) and as much as 12 GB. Memory must be installed in
pairs, starting with bank 1 (slots 1B and 1A).

The controller automatically detects, sizes, and initializes the memory array, depending on the type,
size, and speed of the installed DIMMs, and reports memory size and allocation to the server via
configuration registers.

&> NOTE

Use DIMMs that have been tested for compatibility with the server board.
Contact your sales representative or dealer for a current list of approved
memory modules. Check the Intel Customer Support website for the latest
tested memory list.

http://support.intel.com/

PCI Riser Slots

The server board has two PCI riser slots. Riser slot B provides the following features:
e 184 pin, 5 volt keyed, 64-bit expansion slot connector

e Support for either a 1-slot or a 3-slot PCI riser card

e  Support for both full length and low profile PCI cards

Riser C provides the following features:

e 184 pin, 5 volt keyed, 64-bit expansion slot connector

e Support for either a 1-slot or a 3-slot PCI riser card

e Support for only low profile PCI cards

Video

The SE7500WV2 uses an ATI RAGE XL PCI graphics accelerator with 8 MB of video SDRAM.
The embedded SVGA video subsystem supports:

e Resolutions up to 1600 x 1200 under 2D and 1024 x 768 under 3D
e CRT and LCD monitors up to 100 Hz vertical refresh rate

The server board supports disabling of the onboard video through the BIOS setup menu or when a
plug in video card is installed in any of the PCI slots.

10 Intel Server Board SE7500WV2 Product Guide



SCSI Controller

The SCSI version of the server board includes an embedded Adaptect AIC-7899W controller
providing dual Ultral60 Low Voltage Differential (LVD) SCSI channels.

The SCSI bus is terminated on the server board with active terminators that cannot be disabled.
The onboard device must always be at one end of the bus. The device at the other end of the cable
must also be terminated. LVD devices generally do not have termination built-in and need to have
a termination source provided. Non-LVDs devices generally are terminated through a jumper or
resistor pack on the device itself.

ATA-100 Controller

The ATA version of the server board provides an embedded dual channel ATA-100 bus through the

use of the Promise Technologyt PDC20277 ATA-100 controller. The controller contains two

independent ATA-100 channels that share a single 32-bit, 33-MHz PCI bus master interface as a

multifunction device. The controller supports:

e DMA and PIO IDE drives and ATAPI devices

e ATA and ATAPI proposal PIO Mode 0, 1, 2, 3, 4; DMA Mode 0, 1, 2; and Ultra DMA Mode
0,1,2,3,4,5

e IDE transfer rates up to 100 MB/sec per channel

e Host interface complies with PCI Local Bus Specification Revision 2.2

IDE RAID

The ATA-100 controller supports IDE RAID through both ATA-100 channels. In a RAID
configuration, multiple IDE hard drives are placed into one or more arrays of disks. Each array is
seen as an independent disk, though the array may include one, two, three, or four drives. The IDE
RAID can be configured as follows:

e RAID 0: Striping one to four drives

e RAID 1: Mirroring two drives

e RAID 1 +: Spare drive (three drives)

e RAID 0 +: One to four drives are required

RAID 0 configurations are used for high performance applications, as it doubles the sustained
transfer rate of its drives. RAID 1 configurations are primarily used for data protection. It creates
an identical drive backup to a secondary drive. Whenever a disk write is performed, the controller
sends data simultaneously to a second drive located on a different data channel. With 4 drives

attached to dual ATA-100 channels, two striped drive pairs can mirror each other (RAID 0+1) for
storage capacity and data redundancy.

Description 11



Network Controller

&> NOTE

To ensure EMC product regulation compliance, the system must be used
with a shielded LAN cable.

The server board uses the Intel® 82546EB Fast Ethernett Controller and supports two
10Base-T/1000Base-TX network subsystems.

The 82546EB controller supports the following features:

e 32-bit PCI master interface

e Integrated IEEE 802.3 10Base-T, 100Base-TX and 1000Base-TX compatible PHYT
e [EEE 820.3u auto-negotiation support

e Full duplex support at 10 Mbps, 100 Mbps, and 1000 Mbps operation

e Low power +3.3 V device

On the SE7500W V2, NIC 1 can be used as both a network interface and server management
interface.

NIC Connector and Status LEDs

The 82546 controller drives LEDs on the network interface connector that indicate link/activity on
the LAN and speed of operation. The green LED indicates network connection when on and
TX/RX activity when blinking. The speed LED indicates 1000 Mbps when amber, 100 Mbps when
green, and 10 Mbps when off.

Keyboard and Mouse

The keyboard/mouse controller is PS/2-compatible. If specified through the System Setup Utility
(SSU), the server may be locked automatically if there is no keyboard or mouse activity for a
predefined length of time. Once the inactivity (lockout) timer has expired, the keyboard and mouse
do not respond until the previously stored password is entered. A Y-cable can be used if both a
PS/2 mouse and keyboard are required at the same time.

RJ-45 Serial Port

The rear RJ-45 serial port is a fully functional serial port that supports any standard serial device
and provides support for serial concentrators. For server applications that use a serial concentrator
to access the server management features of the baseboard, a standard 8-pin CAT-5 cable from the
serial concentrator is plugged directly into the rear RJ-45 serial port. The 8 pins of the RJ-45
connector can be configured to match either of two pin-out standards used by serial port devices.
To accommodate either standard, the JSA2 jumper block located directly behind the rear RJ-45
serial port must be jumpered appropriately according to the desired standard.

12 Intel Server Board SE7500WV2 Product Guide



&= NOTE
By default, the RJ-45 serial port is configured to support a DSR signal.

For serial devices that require a DSR signal (default), the J5A2 jumper must be configured in
position 3-4 (Figure 3, B).

For serial devices that require a DCD signal, the jumper must be in position 1-2 (Figure 3, A).

O
O
-~

DCD-DTRto Pin#7 |O O E N DSR-DTR to Pin #7

ﬂ 11 nonnnntY 1

OM14126

Figure 3. J5A2 Jumper Block for DSR Signal

For server applications that require a DB9 serial connector, you must use an 8-pin
RJ-45-to-DB9 adapter. The following table defines the pin-out required for the adapters to provide

RS232 support.
Table 3. Rear Serial 2 Port Adapter Pin-out
RJ-45 Signal Abbreviation DB9
1 Request to Send RTS 7
2 Data Terminal Ready DTR 4
3 Transmitted Data TD 3
4 Signal Ground SGND 5
5 Ring Indicator RI 9
6 Received Data RD 2
7 DCD or DSR DCD/DSR 1or6
8 Clear To Send CTS 8
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ACPI

The SE7500W V2 supports the Advanced Configuration and Power Interface (ACPI) as defined by
the ACPI 2.0 specification. An ACPI aware operating system can put the system into a state where
the hard drives spin down, the system fans stop, and all processing is halted. However, the power
supply will still be on and the processors will still be dissipating some power, so the power supply
fans will still run.

The SE7500W V2 supports sleep states s0, s1, s4, and s5:

e s0: Normal running state.

e sl: Processor sleep state. No context will be lost in this state and the processor caches will
maintain coherency.

e s4: Hibernate or Save to Disk: The memory and machine state are saved to disk. Pressing the
power button or other wakeup event will restore the system state from the disk and resume
normal operation. This assumes that no hardware changes have been made to the system while
it was off.

e s5: Soft off: Only the RTC section of the CSB and the BMC are running in this state. No
context is saved by the OS or hardware.

A CAUTION

The system is off only when the AC power cord is disconnected.

System Management

Intel integrates system management features into the hardware and provides additional features
through Intel® Server Management software. This section describes the integrated hardware
features, Intel Server Management software, and the System Setup Utility and FRU/SDR Load
Utility used to configure the hardware features.

Baseboard Management Controller

Intel server boards incorporate a baseboard management controller (BMC), which is a dedicated
microcontroller for system management activities. The BMC performs the following functions:

e Monitors system components and sensors, including processors, memory, fans, power supplies,
temperature sensors, and chassis intrusion sensors.

e Manages nonvolatile storage for the system event log (SEL), sensor data records (SDRs), and
baseboard field-replaceable unit (FRU) inventory.

e Interfaces with the emergency management port (EMP) and LANT1 port to send alerts and
interact with remote management systems.

e Provides the main front panel control functions (power on/off, reset, and so on).

14 Intel Server Board SE7500WV2 Product Guide



Field Replaceable Units and Sensor Data Records

Field replaceable units (FRUs) are major modules in the chassis that contain active electronic
circuitry. FRUs can store information-such as board serial number, part number, name, and asset
tag-that can be read using the System Setup Utility (page 49). The BMC stores FRU information
for the baseboard in a nonvolatile storage component on the board.

The BMC uses Sensor Data Records (SDRs) to identify the sensors in the system for monitoring.
SDRs provide a list of the sensors, their characteristics, location, type, and type-specific
information, such as default threshold values, factors for converting a sensor reading into the
appropriate units (mV, rpm, degrees Celsius), and information on the types of events that a sensor
can generate. The BMC stores SDR information in a nonvolatile storage component on the
baseboard.

You can use the FRU/SDR Load Utility (page 57) to initialize or update the FRU and SDR
information. Intel server boards are shipped from the factory with some sensors disabled, because
the actual configuration of the chassis is only determined when the user completes the system
configuration. Chassis-specific information in the FRU, such as chassis part number, is also absent.
For these reasons, it is important to run the FRU/SDR Load Utility as part of the system setup
process. You should also run the FRU/SDR Load Utility whenever you change the number of fans,
processors, or power supplies in the server.

System Event Log

The BMC manages a system event log (SEL), where it records significant or critical system events.
Such events include temperatures and voltages out of range, fan failures, and other sensor-related
events. The BIOS, software, and other devices can also log events by sending messages to the
BMC. The SEL is stored in nonvolatile storage.

You can view the current contents of the SEL by using the System Setup Utility (page 48).

Platform Event Management

Events can trigger alerts and other actions by the BMC. The server is configured with the
following set of standard events:

e Temperature sensor out of range

e Voltage sensor out of range

e Fan failure

e Chassis intrusion

e Power supply fault

e BIOS uncorrectable ECC error

e BIOS POST error

e Processor fault resilient booting (FRB) failure

e Fatal nonmaskable interrupt (NMI) from a source other than the front panel switch
e  Watchdog timer reset, power down, or power cycle

e System restart (reboot)
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Alerts can take either of these forms:

e Platform event pages -- the BMC dials a paging service and sends a predefined paging string.
To use platform event paging (PEP), you must attach an external modem to the emergency
management port (Serial 2).

e BMC LAN alerts -- the BMC sends an alert to a predefined destination on the LAN.

You can configure PEP and BMC LAN alerts by using the System Setup Utility (page 51).

Emergency Management Port

The emergency management port (EMP) refers to the use of the Serial 2 port, with either an
external modem or direct serial connection, for remote management. The BMC controls the port
and interfaces with remote access software, such as the Direct Platform Control application in Intel
Server Management.

You can configure the EMP by using the System Setup Utility (SSU) or the System Configuration
Wizard (SCW).

EMP and Serial Over LAN

The RJ-45 Serial 2 port on the back panel can be configured in several different ways: as a
standard serial port, as an Emergency Management Port, or for serial output redirection over a
LAN. You can configure these settings using either the SSU or the SCW.

&> NOTES

Important Intel SR1300 Server Chassis considerations: If you have
configured the Serial 2 port for use as an Emergency Management Port and
“always available”, the Serial 2 port will be accessible only by remote server
management software. The operating system will never be able to access the
port.

If you have configured the Serial 2 port for Serial Over LAN, the port’s
functionality will only be impacted when there is an active Serial Over LAN
session from a remote console. At all other times either the operating system
or EMP will control the port, depending on your configuration.

Intel® Server Management

16

Intel Server Management (ISM) is a system management package that is included on the ISM CD.

ISM applications interact with the integrated hardware system management features of the server to

allow you to monitor and manage a server from a remote workstation:

e Remote connection from a WindowsT-based client workstation over a LAN, or over a modem
or direct serial connection to the emergency management port on the server.

e Real-time monitoring and alerting for server hardware sensors.

e Emergency management when the server is off (but still connected to AC power) lets you
verify the state of the server, diagnose hardware problems, and power on/off or reset the server.

e Run the System Setup Utility to change the server configuration.
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ISM can use an optional service partition on the server that you are managing. The service partition
is a special disk partition on the system drive that contains a ROM-DOST operating system and

DOS-based utilities, including the System Setup Utility, FRU/SDR Load Utility, and Remote
Diagnostics. The server can be booted to the service partition, either locally or remotely, to provide
access to the utilities.

For more information on Intel Server Management and the individual ISM applications, see the
ISM CD.

Security

Intrusion Switch Monitoring

To help prevent unauthorized entry or use of the server, Intel Server Management server
management software monitors the chassis intrusion switch if one is installed. Opening an access
cover will transmit an alarm signal to the server board, where BMC firmware and server
management software process the signal. The system can be configured through ISM to respond to
an intrusion a number of ways, including powering down or locking the keyboard.

Software Locks

The BIOS Setup and the System Setup Utility (SSU) provide a number of security features to
prevent unauthorized or accidental access to the system. Once the security measures are enabled,
you can access the system only after you enter the correct password(s). For example:

e Enable the keyboard lockout timer so that the server requires a password to reactivate the
keyboard and mouse after a specified time out period31 to 120 minutes.

e Set and enable a supervisor password.

e Set and enable a user password.

e Set secure mode to prevent keyboard or mouse input and to prevent use of the front panel reset
and power switches.

e Activate a hot key combination to enter secure mode quickly.
¢ Disable writing to the diskette drive when secure mode is set.
e Disable access to the boot sector of the operating system hard disk drive.

Using Passwords

You can set either the user password, the supervisor password, or both passwords. If only the user
password is set, you:

e  Must enter the user password to enter BIOS Setup or the SSU.

e  Must enter the user password to boot the server if Password on Boot is enabled in either the
BIOS Setup or SSU.

e Must enter the user password to exit secure mode.
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If only the supervisor password is set, you:

e Must enter the supervisor password to enter BIOS Setup or the SSU.

e  Must enter the supervisor password to boot the server if Password on Boot is enabled in either
the BIOS Setup or SSU.

e Must enter the supervisor password to exit secure mode.

If both passwords are set, you:

e May enter the user password to enter BIOS Setup or the SSU. However, you will not be able to
change many of the options.

e  Must enter the supervisor password if you want to enter BIOS Setup or the SSU and have
access to all of the options.

e May enter either password to boot the server if Password on Boot is enabled in either the BIOS
Setup or SSU.

e May enter either password to exit secure mode.

Secure Mode

18

Configure and enable the secure boot mode by using the SSU. When secure mode is in effect:

e You can boot the server and the operating system will run, but you must enter the user
password to use the keyboard or mouse.

e You cannot turn off system power or reset the server from the front panel switches.

Secure mode has no effect on functions enabled via remote server management or power control
via the watchdog timer.

Taking the server out of secure mode does not change the state of system power. That is, if you
press and release the power switch while secure mode is in effect, the system will not be powered
off when secure mode is later removed. However, if the front panel power switch remains
depressed when secure mode is removed, the server will be powered off.

Intel Server Board SE7500WV2 Product Guide



Summary of Software Security Features

The table below lists the software security features and describes what protection each offers. In
general, to enable or set the features listed here, you must run the SSU and go to the Security
Subsystem Group, menu. The table also refers to other SSU menus and to the Setup utility.

Table 4.

Software Security Features

Feature

Description

Secure mode

How to enter secure mode:

¢ Setting and enabling passwords automatically places the system in secure
mode.

¢ If you set a hot-key combination (through Setup), you can secure the system
simply by pressing the key combination. This means you do not have to wait
for the inactivity time-out period.

When the system is in secure mode:

e The server can boot and run the operating system, but mouse and keyboard
input is not accepted until the user password is entered.

e At boot time, if a CD is detected in the CD-ROM drive or a diskette in drive A,
the system prompts for a password. When the password is entered, the
server boots from CD or diskette and disables the secure mode.

o If there is no CD in the CD-ROM drive or diskette in drive A, the server boots
from drive C and automatically goes into secure mode. All enabled secure
mode features go into effect at boot time.

To leave secure mode: Enter the correct password(s).

Disable writing to
diskette

In secure mode, the server will not boot from or write to a diskette unless a
password is entered.

To write protect access to diskette whether the server is in secure mode or not,
use the Setup main menu, Floppy Options, and specify Floppy Access as read
only.

Set a time out period so
that keyboard and
mouse input are not
accepted

Also, screen can be
blanked, and writes to
diskette can be inhibited

Specify and enable an inactivity time out period of from 1 to 120 minutes.

If no keyboard or mouse action occurs for the specified period, attempted
keyboard and mouse input will not be accepted.

The monitor display will go blank, and the diskette drive will be write protected (if
these security features are enabled through Setup).

To resume activity: Enter the correct password(s).

Control access to using
the SSU: set supervisor
password

To control access to setting or changing the system configuration, set a
supervisor password and enable it through Setup.

If both the supervisor and user passwords are enabled, either can be used to
boot the server or enable the keyboard and/or mouse, but only the supervisor
password will allow Setup to be changed.

To disable a password, change it to a blank entry or press CTRL-D in the
Change Password menu of the Supervisor Password Option menu found in the
Security Subsystem Group.

To clear the password if you cannot access Setup, change the Clear Password
jumper (see Chapter 6).

Description

continued
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Table 4. Software Security Features (continued)

Feature

Description

Control access to the
system other than SSU:
set user password

To control access to using the system, set a user password and enable it
through Setup.

To disable a password, change it to a blank entry or press CTRL-D in the
Change Password menu of the User Password Option menu found in the
Security Subsystem Group.

To clear the password if you cannot access Setup, change the Clear Password
jumper (see Chapter 6).

Boot without keyboard

The system can boot with or without a keyboard. During POST, before the
system completes the boot sequence, the BIOS automatically detects and tests
the keyboard if it is present and displays a message.

Specify the boot
sequence

The sequence that you specify in setup will determine the boot order. If secure
mode is enabled (a user password is set), then you will be prompted for a
password before the server fully boots. If secure mode is enabled and the
“Secure Boot Mode” option is also enabled, the server will fully boot but will
require a password before accepting any keyboard or mouse input.
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2 Installation Procedures

Rearrange the Standoffs

If your chassis does not have board mount standoffs placed as shown, you must rearrange them so
they match the holes in the server board. Failure to properly rearrange the metal standoffs may
cause the server board to malfunction and may permanently damage it. Your chassis may be
different from the illustration.
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Figure 4. Rearrange the Standoffs
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Install the Server Board

To ensure proper grounding and support, it is recommended that you install screws in all the
required mounting holes for your chassis. You may need to move cables out of the way to properly
install your server board.

1. While placing the board on the chassis standoffs, carefully position the board I/O connectors
into the rear chassis I/O openings.

2. Adjust board position to align mounting holes with standoffs.

3. Using the screws that came with your chassis, mount the board to the chassis.

&> NOTE

If you install the server board into an Intel SR1300 or SR2300 chassis, you
will not use all of the mounting holes. See your chassis documentation for

more details.
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Figure 5. Installing the Server Board
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Install the Processor Retention Brackets

There are four brackets, two for each processor socket. For each bracket, do the following:

&
=
=

Place the bracket (A) on the server board.

1.
Insert and tighten two screws (B) to secure the bracket.

2.

@@

OM14144

Figure 6. Installing the Processor Retention Brackets

Installing Processors

1. Raise the locking bar on the socket.

OM14132

Figure 7. Raising the Locking Bar

Installation Procedures
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2. Aligning the pins of the processor with the socket, insert the processor into the socket.

OM14133

Figure 8. Installing Processors

3. Lower the locking bar completely.

OM14135

Figure 9. Lower Locking Bar

Intel Server Board SE7500WV2 Product Guide



4. Follow the instructions packaged with your boxed processor for preparing the heat sink and
processor for installation.

5. Position the heat sink above the processor.

6. Aligning the raised metal surfaces, place the heat sink on top of the processor.

OM14134

Figure 10. Installing the Heat Sink

Installation Procedures

25



26

7. Place the heat sink clip (1) so the tab on the clip engages the slot on the heat sink (A).
8. Press one end of the clip down (2).
9. Press the other end of the clip down (3).

OM14140

Figure 11. Installing the Heat Sink Clip

Intel Server Board SE7500WV2 Product Guide



Memory

Only DDR-200 or DDR-266 compliant SDRAM is supported by the server board. Install from
256 MB to 12 GB of registered, ECC memory, using up to six DIMMs. A 1U chassis requires low-
profile (LP) 1.2-inch DIMMs.

DIMMs must be installed in pairs and in the following order: 1B and 1A, 2B and 2A, 3B and 3A.

Installed DIMMs must be the same speed and must all be registered. For a list of supported
memory, call your service representative or visit the Intel Support website:

http://support.intel.com
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Figure 12. Installing Memory
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Connect Cables

Before connecting cables, consult the documentation supplied with your chassis.

28
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External SCSI channel A connector (SCSI server board only)
Internal SCSI channel B connector (SCSI server board only)
Serial 1 header

Combined Floppy/Front Panel/IDE connector (For use in an Intel® chassis only)
Fan module connector

Fan module connector

Processor fan connectors (For use in a non Intel chassis only)
Auxiliary power connector

Main power connector

Power supply signal connector

Front panel connector (For use in a non Intel chassis only)
Floppy connector (For use in a non Intel chassis only)

IDE connector (For use in a non Intel chassis only)

USB header

ATA-100 primary/secondary connectors (ATA server board only)

Figure 13. Connecting Cables

Intel Server Board SE7500WV2 Product Guide



Getting Started with Intel Server Management and
Intel® SMaRT Tool (Optional)

Intel Server Management and the hard drive Service Partition provide real-time monitoring and
alerting for your SE7500W V2 server hardware, emergency remote management, and remote server
setup. Intel Server Management is implemented by installing it within client-server architecture.

The Service Partition provides you with the ability to remotely access a local partition on the server
and to identify and diagnose server health issues. Remote access is provided through either a
modem or network connection.

To get started with Intel Server Management, install the Service Partition first, then the system’s
operating system, and finally Intel Server Management. The information here describes installation
on a system running a Microsoft Windows operating system.

The Intel Server Maintenance and Reference Training (SMaRT) Tool is an interactive software tool
providing support information to assist with the maintenance and repair of Intel-based server
systems and accessories. SMaRT Tool features visual, step-by-step instructions for replacing parts;
a complete Field Replaceable Unit (FRU) database containing part numbers and images; product
spares lists, and worldwide Intel support information.

Intel Server Management provides an interface to the Intel® SMaRT Tool, combining remote error
detection and alerting with interactive maintenance and repair assistance. When Intel Server
Management detects a hardware error and a part needs replacing, SMaRT Tool can be launched
directly from Intel Server Management to locate the correct part information and corresponding
“How to Replace” steps required to quickly get the server back up and running.

To activate Intel Server Management’s interface with the Intel SMaRT Tool, both software
programs need to be installed. You can install the software on a server or on a workstation used to
manage the server. The information here describes installation on a system running a Microsoft
Windows operating system. For other operating systems, see the Installation Guide & User Guide
located in the ISM/DOCS folder on the Intel Server Management CD-ROM. SMaRT Tool and ISM
Console may only be installed on a system running a Microsoft Windows operating system.

&> NOTE

Prior to installation, uninstall any previous version of Intel Server Management.

Installing a Service Partition on the Server (Optional)

The Service Partition provides advanced remote management and configuration functionality.
Installing it on a server is optional.

1. Power-on the server, insert the Intel Server Management CD into the CD-ROM drive, and boot
to the CD.

Select Utilities > Run Service Partition Administrator > Create Service Partition-first time.
Select an available hard drive. The server will reboot to the CD.

Select Format Service Partition and Install Software.

Exit the menu. Remove the CD and reboot to install the server operating system. After
installing the operating system, proceed to Intel Server Management Installation.

ke
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Installing your Operating System

Install your operating system now.

Installing Intel Server Management

You can install Intel Server Management on a local server or on a remote workstation that is used

to manage a LAN/WAN.

1. Insert the Intel Server Management CD into the system’s CD-ROM.

2. Click Install Server Management.

3. Select the applicable system option.

4. Review the Intel Software License Agreement and click Accept.

5. [Ifinstalling to a local server, click Install Now. If this is a multiple system installation, click

6.
7.

Add to compile a list of systems and then click Install Now.
Select Reboot Now or Reboot Later.
Remove the Intel Server Management CD.

Installing Intel SMaRT Tool

Follow the instructions below to install the Intel Server Maintenance and Reference Training Tool
(SMaRT Tool) on your system.

NOTE

30
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10.

11.

SMaRT Tool may only be installed on a system running a Microsoft
Windows operating system.

To download the SE7500WV2 SR1300 or SE7500W V2 SR2300 server

system module for SMaRT Tool, you must have Internet access.
Insert the System Resource CD into the system’s CD-ROM drive.
Click on Intel SMaRT Tool in the menu on the left side of the screen.
In the green Make a Selection drop-down menu, select SMaRT Tool Install Guide. Print the
Guide, and keep it on hand for reference.
Review the SMaRT Tool Install Guide prior to proceeding.
In the Make a Selection drop-down menu, select Install SMaRT Tool.
Click on the Run Installer icon to launch the SMaRT Tool Setup program.
Follow the on-screen installation instructions. Review the Intel Software License Agreement
and click Accept. When installation is complete, launch SMaRT Tool.
In SMaRT Tool’s Welcome page, click on Systems.
Select Select System > Servers > Xeon > SE7500WV2 SR1300 or SE7500WV2 SR2300 and
then follow the on-screen instructions to download the module. When the download is
complete, SMaRT Tool will restart.
Select Systems > Select System > Servers > Xeon > SE7500WV2 SR1300 or SE7500WV2
SR2300 to access information on your new server system.
You can invoke SMaRT Tool directly from Intel Server Management’s Platform
Instrumentation Control application by clicking on the SMaRT Tool icon, or by selecting
Launch SMaRT Tool from the SMaRT Tool menu. The interface between the two programs
is context-sensitive. To find out more about the integration between Intel SMaRT Tool and
Intel Server Management, please select SMaRT Tool and Server Management in the Make a
Selection drop-down menu.
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3 Upgrading

Tools and Supplies Needed

Jumper removal tool or needle nosed pliers

PhillipsT (cross head) screwdriver (#1 bit and #2 bit)

Pen or pencil

Antistatic wrist strap and conductive foam pad (recommended)

Cautions

These warnings and cautions apply throughout this chapter. Only a technically qualified person
should configure the server board.

/A CAUTIONS

System power on/off: The power button DOES NOT completely turn off
the system AC power, 5V standby is still active whenever the system is
plugged in. To remove power from system, you must unplug the AC power
cord from the wall outlet. Make sure the AC power cord is unplugged before
you open the chassis, add, or remove any components.

Hazardous conditions, devices & cables: Hazardous electrical conditions
may be present on power, telephone, and communication cables. Turn off
the server and disconnect the power cord, telecommunications systems,
networks, and modems attached to the server before opening it. Otherwise,
personal injury or equipment damage can result.

Electrostatic discharge (ESD) & ESD protection: ESD can damage disk
drives, boards, and other parts. We recommend that you perform all
procedures in this chapter only at an ESD workstation. If one is not
available, provide some ESD protection by wearing an antistatic wrist strap
attached to chassis ground¥any unpainted metal surface%4on your server
when handling parts.

ESD and handling boards: Always handle boards carefully. They can be
extremely sensitive to ESD. Hold boards only by their edges. After
removing a board from its protective wrapper or from the server, place the
board component side up on a grounded, static free surface. Use a
conductive foam pad if available but not the board wrapper. Do not slide
board over any surface.

Installing or removing jumpers: A jumper is a small plastic encased
conductor that slips over two jumper pins. Some jumpers have a small tab on
top that you can grip with your fingertips or with a pair of fine needle nosed
pliers. If your jumpers do not have such a tab, take care when using needle
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nosed pliers to remove or install a jumper; grip the narrow sides of the
jumper with the pliers, never the wide sides. Gripping the wide sides can
damage the contacts inside the jumper, causing intermittent problems with
the function controlled by that jumper. Take care to grip with, but not
squeeze, the pliers or other tool you use to remove a jumper, or you may
bend or break the stake pins on the board.

Memory

32

The server board supports from 256 MB up to 12 GB of registered memory in six DIMM slots.

NOTES

e Only DDR-200 or DDR-266 compliant RAM is supported by the server board.
e A 1U chassis requires low-profile (LP) 1.2-inch (30 mm) tall DIMMs.
e DIMMs must be populated in pairs and in the following order:
— 1B and 1A, then 2B and 2A, then 3B and 3A.
e Installed DIMMs must be the same speed and must all be registered.

For a list of supported memory, call your service representative or visit the Intel Customer Support
website:

http://support.intel.com

© 1 | o @D .
© 1B 2B 3B &
i | izl ]
—
1 ,
E T
I J
H o | =
—© © © o

——

ﬂ@u
D@H—Lﬂ h o o

Figure 14. Installing DIMMs
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Processors

A WARNING

If the server has been running, any installed processor and heat sink on
the processor board(s) will be hot. To avoid the possibility of a burn, be
careful when removing or installing server board components that are
located near processors.

A CAUTION

Processor must be appropriate: You may damage the server if you install
a processor that is inappropriate for your server. Make sure your server can
handle a newer, faster processor (thermal and power considerations). For
exact information about processor interchangeability, contact your customer
service representative or visit the Intel Customer Support website:

http://support.intel.com/

ESD and handling processors: Reduce the risk of electrostatic discharge
(ESD) damage to the processor by doing the following: (1) Touch the metal
chassis before touching the processor or server board. Keep part of your
body in contact with the metal chassis to dissipate the static charge while
handling the processor. (2) Avoid moving around unnecessarily.

Adding or Replacing a Processor

If you are adding a second processor to your system, the second processor must be compatible with
the first processor (within one stepping, same voltage, same speed, see the Intel Customer Support
website for specifics).

1. Observe the safety and ESD precautions at the beginning of this document.

2. Raise the locking bar on the socket.

OM14132

Figure 15. Raising the Locking Bar
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3. Aligning the pins of the processor with the socket, insert the processor into the socket.

OM14133

Figure 16. Installing Processors

4. Lower the locking bar completely.

OM14135

Figure 17. Lower Locking Bar

5. Follow the instructions packaged with your boxed processor for preparing the heat sink and
processor for installation.

6. Position the heat sink above the processor.

7. Aligning the raised metal surfaces, place the heat sink on top of the processor.

Intel Server Board SE7500WV2 Product Guide



OM14134

Figure 18. Installing the Heat Sink

8. Place the heat sink clip (1) so the tab on the clip engages the slot on the heat sink (A).
9. Press one end of the clip down (2).
10. Press the other end of the clip down (3).

OM14140

Figure 19. Installing the Heat Sink Clip
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Removing a Processor

1. Observe the safety and ESD precautions at the beginning of this chapter and the additional
cautions given here.

2. [If processor wind tunnel is installed, unplug it from the server board and remove it from the
heat sink.

3. Disengage the retention clip from the processor socket.

4. Remove the processor from the socket.

Replacing the Back up Battery

36

The lithium battery on the server board powers the real time clock (RTC) in the absence of AC
power. When the battery starts to weaken, it loses voltage, and the server settings stored in CMOS
RAM in the RTC (for example, the date and time) may be wrong. Contact your customer service
representative or dealer for a list of approved devices.

WARNING

Danger of explosion if battery is incorrectly replaced. Replace only with
the same or equivalent type recommended by the equipment
manufacturer. Discard used batteries according to manufacturer’s
instructions.

ADVARSEL!

Lithiumbatteri - Eksplosionsfare ved fejlagtig handtering. Udskiftning
ma kun ske med batteri af samme fabrikat og type. Levér det brugte
batteri tilbage til leverandgren.

ADVARSEL

Lithiumbatteri - Eksplosjonsfare. Ved utskifting benyttes kun batteri
som anbefalt av apparatfabrikanten. Brukt batteri returneres
apparatleverandgren.

VARNING

Explosionsfara vid felaktigt batteribyte. Anvind samma batterityp eller
en ekvivalent typ som rekommenderas av apparattillverkaren. Kassera
anviant batteri enligt fabrikantens instruktion.

VAROITUS

Paristo voi rijahtia, jos se on virheellisesti asennettu. Vaihda paristo
ainoastaan laitevalmistajan suosittelemaan tyyppiin. Héviti kaytetty
paristo valmistajan ohjeiden mukaisesti.
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To replace the battery:

Before proceeding, record your custom BIOS settings.

Observe the safety and ESD precautions at the beginning of this chapter.
Open the chassis and locate the battery.

Push the upper end of the metal retainer away from the battery-the battery pops up.
Remove the battery from its socket.

Dispose of the battery according to local ordinance.

Remove the new lithium battery from its package.

Being careful to observe the correct polarity, lay the battery in the socket.
Push the battery down-the metal retainer locks the battery in the socket.
10 Close the chassis.

11. Run Setup to restore the configuration settings to the RTC.

12. Restore your custom BIOS settings.
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Figure 20. Replacing the Back up Battery
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4 Configuration Software and Utilities

Service Partition (Optional)

When you are setting up your server system, you can install a service partition onto your hard drive.
The service partition includes utilities, and other software that be run locally or remotely to assist in
system management. The service partition uses approximately 40 MB of hard disk space.

&> NOTE

It is highly recommended that you install the service partition before
installing an operating system. For more information, see the Service
Partition section in the Installation Guide for Intel Server Management. This
document is included on the ISM CD shipped with your server board.

Configuration Utilities

System Software Update Sequence

When you update the system software, you should do it in the following order.

1.

2. Update FRU/SDR
3.

4. Update BIOS

5. Clear CMOS

Update firmware (BMC & HSC)

Unplug system for 30 seconds

Table 5. Configuration Utilities

Utility Description and brief procedure Page
Adaptec SCSISelect! Use to configure or view the settings of the SCSI host adapters and 42
Utility onboard SCSI devices in the system.
Direct Platform Control Use to access and monitor the server remotely. 43
(DPC) Console
System Setup Utility Use for viewing and configuring server management options, viewing 45
(SSU) and Client the system event log (SEL), setting boot device priority, or setting
System Setup Utility system security options.
(CSsU) The SSU can run either from the configuration software CD or from a

set of bootable diskettes. You can create the diskettes from the CD.

The CSSU is run from the service partition via the DPC console. It

provides the same functionality as the SSU, but from a remote console.

Information entered via the SSU/CSSU overrides information entered

via BIOS Setup.

continued
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Table 5. Configuration Utilities (continued)

Utility Description and brief procedure Page
BIOS Update Utility Use to update the BIOS or recover from a corrupted BIOS update. 50, 56
Firmware Update Utility | Use to update BMC flash ROM or other firmware. 57
FRU/SDR Load Utility Use to update the Field Replaceable Unit (FRU) and Sensor Data 57

Record (SDR) flash components.

NOTE: You must run the FRU/SDR Load utility whenever the BMC is
updated or if you change your processors.

Hot Keys

Use the numeric pad of the keyboard to enter numbers and symbols.

Table 6. Hot Keys

To Do This:

Press These Keys

Secure your system immediately.

the SSU or BIOS Setup)

<Ctrl+Alt>+hot key (Set your hot key combination with

Enter the Adaptec SCSI Utility during POST. <Ctrl+A> (SCSI version only)

Enter the Promise Technology IDE RAID Utility. <Ctrl+F> (ATA version only)

Enter BIOS Setup during POST. <F2>

Abort memory test during POST. <ESC> (Press while BIOS is updating memory size on
screen)

Display a menu for selecting the boot device. <ESC> (Press anytime after memory check)

To remove the splash screen. <ESC>

Power-On Self-Test (POST)

Each time you turn on the system the BIOS begins execution of the Power-On Self-Test (POST).

POST discovers, configures, and tests the processors, memory, keyboard, and most installed

peripheral devices. The time needed to test memory depends on the amount of memory installed.
POST is stored in flash memory.

1. Turn on your video monitor and system. After a few seconds, POST begins to run and displays

a splash screen.

2. While the splash screen is displayed:
e Press <F2> to enter the BIOS Setup (see “BIOS Setup”)

OR

e Press <Esc> to view POST diagnostic messages and change the boot device priority for this
boot only (see “Temporarily Changing the Boot Device Priority” on page 41).
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3. After pressing <F2> or <Esc> during POST, you can press <Ctrl+A> to run the SCSISelect
Utility. For more information, see “Running the Adaptec SCSISelect Utility” on page4?2.

4. If you do not press <F2> or <Esc> and do NOT have a device with an operating system loaded,
the boot process continues and the system beeps once. The following message is displayed:

Operating System not found

5. At this time, pressing any key causes the system to attempt a reboot. The system searches all
removable devices in the order defined by the boot priority.

BIOS Setup

You can run BIOS Setup with or without an operating system being present. BIOS Setup stores
most of the configuration values in battery-backed CMOS; the rest of the values are stored in flash
memory. The values take effect when the system is booted. POST uses these values to configure
the hardware. If the values and the actual hardware do not agree, POST generates an error
message.

Record BIOS Setup Settings

Record your BIOS Setup settings. If default values ever need restoring (after a CMOS clear, for
example), you must run BIOS Setup again. Your record will make this much easier.

If BIOS Setup Is Inaccessible

If you have a misconfigured diskette drive, and you cannot use BIOS Setup to correct the problem,
you might need to clear CMOS memory. To clear CMOS, either of two methods can be used.

1. Press the reset button and hold it down for four seconds or more, and then, while holding the
reset button down, press the power button. Release both buttons at the same time.
2. Move the Clear CMOS jumper found on the configuration jumper block on the baseboard.

Temporarily Changing the Boot Device Priority

During POST, you can change the boot device priority for the current boot process. The changes
are not saved for the next boot process.

1. Boot the server.

2. At any time during POST, press <Esc>. When POST completes, a popup Boot menu displays.
3. Use the arrow keys to highlight the device you want the server system to boot from first. For

example, if you want the server system to boot from the CD-ROM first, you select “ATAPI
CD-ROM Drive.”

&> NOTE

One of the selections on the popup Boot menu is “Enter Setup.” Selecting
this option brings you into the BIOS Setup.

4. Press <Enter>.
5. The boot process continues. When finished, a system prompt displays.
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Running the Adaptec SCSISelect Utility

Each host adapter includes an onboard SCSISelect configuration utility that allows you to
configure/view the settings of the host adapter and devices in the server.

The system finds the Adaptec AIC-7899 SCSI host adapter and displays the message Adaptec
AIC-7899 SCSI BIOS V x.xxx where x.xxx is the version number of the SCSISelect utility.

Pressing <Ctrl+A> at this time allows you to configure the
Adaptec AIC-7899 SCSI host adapter.

When to Run the Adaptec SCSISelect Utility
Use the SCSISelect utility to:

e Change default values

e Check and/or change SCSI device settings that may conflict with those of other devices in the
server

e Do alow-level format on SCSI devices installed in the server

Running the SCSISelect Utility

1. When this message appears on the video monitor:
<<<Press <Ctrl><A> for SCSISelect(TM) Utility!>>>

2. Press <Ctrl+A> to run the utility. When the main menu for the host adapter appears, choose
the device that you want to configure-each SCSI bus accepts up to 15 devices.

Use the following keys to navigate through the menus and submenus:

Table 7. SCSlSelect Navigation Keys

Press To

ESC Exit the utility

Enter Select an option

T Return to a previous option

d Move to the next option

F5 Switch between color and monochrome
F6 Reset to host adapter defaults

Configuring the Adaptec AIC-7899 SCSI Adapter

The Adaptec AIC-7899 SCSI adapter has two busses. Select the bus from the following menu:

Table 8. Adaptec Main Menu

Menu Item Options
You have an AIC-7899 adapter in your system. Bus:Device:Channel
Move the cursor to the bus:device:channel of the 01:06:A

one for configuration and press <Enter>. 01:06:B

<F5> - Toggle color/monochrome.
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After selecting the bus, the following menu displays:

Table 9. Menu for each SCSI Channel

Host Adapter Option Comment

AIC-7899 at Configure/View Press <Enter> to view the Configuration Menu.
Bus:Device:Channel Host Adapter

01:06:A (or 01:06:B) Settings

media.

SCSI Disk Utilities Press <Enter> to view the SCSI Disk Utilities Menu. This
menu allows you to format hard disks and/or verify disk

When you are finished, press <Esc> and make your selection from the following menu:

Table 10. Exit Menu

Feature Option Comment
Exit Utility? Yes When you finish configuring your SCSI devices, press <Esc>. Then select Yes
No and press <Enter>. When this message appears:

Please press any key to reboot.

Press any key, and the server reboots.

Running the Promise FastBuild Utility

This utility is only found on the SE7500WV2 ATA model only.

The Promise ATA-100 host adapter is configured using the FastBuildt configuration utility that
allows you to configure/view the settings of the host adapter and set RAID configurations.

When to Run the Promise FastBuild Utility

Use the FastBuild utility to:

e Define a RAID array
e Delete a RAID array
e Restore a RAID array

Running the Promise FastBuild Utility

1. When this message appears on the video monitor:
<<<Press <Ctrl><F> to enter FastBuild (TM) Utility>>>
2. Press <Ctrl+F> to run the utility.

Direct Platform Control (DPC) Console

Direct Platform Control (DPC) Console is part of Intel Server Management. Direct Platform

Control is a server management application that supports remote system management via LAN, or

an RS-232 serial connection to the server serial 2 port over a modem or a direct serial cable. The
Direct Platform Control Console provides the ability for remote management of Intel servers via

modem or LAN with a capability to run DOS-based programs.
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DPC console runs on a client workstation. It communicates with a server by:

Accessing the server management capabilities of the on-board NIC
A Windows 2000 compatible modem.
An RS-232 connection to the server’s serial 2 port.

DPC Console is independent of the server operating system.

Even when the server is off, you can use DPC Console to verify the state of a server or diagnose a
problem with the server hardware. DPC console features allows you to:

Establish connection to remote servers

Server Control: power on, power off, and reset operations

Retrieve and display entries in the System Event Log (SEL)

Retrieve and display Sensor Data Records (SDR)

Retrieve and display Field Replaceable Unit (FRU) information
Retrieve and display current Remote Sensor Access (RSA) information
Access a phonebook for remote connection management

Remote control of the service partition

File transfer from / to the server

DPC Console Modes of Operation

There are four DPC console modes of operation:
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EMP mode. Access the DPC console features using the DPC console window menus and/or
toolbar. Active when a connection is established through the EMP port.

DPC over LAN mode. Access the DPC console features using the DPC console window
menus and/or toolbar. Active when a connection is established through the LAN.

Re-direct mode. Active when the server is running BIOS console redirection. In this mode, the
DPC console launches a separate window. The window operates as an ANSI terminal and
communicates with the server through the port. Character-based commands you type in the
DPC Console go directly to the server, and the DPC Console displays the text that you would
normally see on the server console.

To use this mode, you must configure the Console Redirection option of BIOS Setup for Re-
direct mode. Enabling Console Redirection requires that the Boot Time Diagnostics Screen be
Enabled in BIOS Setup. If the redirection window does not display information, the Console
Redirection is either incorrectly configured or disabled, the EMP is disabled in BIOS Setup, or
the server is in protected mode. For DPC to function, the server must NOT be in graphics
mode.

If the DPC console fails to connect in EMP within 10 seconds and the server can operate in Re-
direct mode, a prompt is displayed with the option to switch to Re-direct mode.

Service Partition mode. Entered when the server reboots from the service partition and the
DPC Console has successfully connected to the server through a modem. This mode allows
running of DOS-based programs that are stored on the service partition and transferring of files.
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Running the DPC Console

For more information about setting up and running the DPC Console, see the document named
“ISM_Install_Guide.pdf.” This document is in the ISM\DOCS directory on the ISM CD
accompanying the SE7500W V2 server board.

Using the System Setup Utility

The System Setup Utility (SSU) is located on the System Resource CD-ROM shipped with the
server.

Run the System Setup Utility to:

e Set boot device priority

e Set passwords and security options

e View system events

¢ View FRU information

e View sensor data records

e Update system firmware and BIOS

e Save and restore the system configuration

e Set up the server to send alerts for platform events

e Set up the server for remote management

Using either the System Setup Utility or BIOS Setup, you can specify the boot device sequence and
set up system passwords and security options. Both utilities access the same stored configuration

data for these items, and the result of making a change to these settings using either utility is
identical.

The SSU consists of a collection of task-oriented modules plugged into a common framework
called the Application Framework (AF). The Application Framework provides a launching point
for individual tasks and a location for setting customization information.

Creating SSU Diskettes
You can run the SSU directly from the Utilities menu of the System Resource CD-ROM, from a set
of DOS diskettes, or from the service partition of the hard disk.

If you choose to run the SSU from a set of DOS diskettes, you must create the SSU diskettes from
the Resource CD-ROM as follows:

1. Boot to the System Resource CD-ROM.
2. Choose Create Diskettes > Create Diskettes by Device/Function > System Setup Utility.
3. Follow the instructions displayed.

Alternatively, if you have a workstation with the Microsoft Windows operating system, you can
insert the CD into that system and create the diskettes on that system.
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Running the SSU

When the SSU starts in the default local execution mode, the SSU accepts input from the keyboard
or mouse. The SSU presents a VGA-based GUI on the primary monitor.

If you run the SSU from read-only media, such as the CD-ROM, you cannot save user preference
settings (such as screen colors).

The SSU supports ROM-DOS version 6.22. The SSU will not operate from a “DOS box” running
under an operating system such as Windows.

Start the SSU using one of the following methods:

e From diskettes: Insert the first SSU diskette in drive A and boot the server from the diskette.
You are prompted to insert the second diskette. After loading completes the SSU starts
automatically.

e From the System Resource or ISM CD-ROM: Boot the server to the System Resource CD and
start the SSU from the Utilities menu.

e From the Service Partition: Boot the server to the Service Partition and execute the following
DOS commands:

C:\> cd ssu

C:A\SSU> ssu.bat
The mouse driver loads if it is available; press <Enter> to continue.

When the SSU title appears on the screen, press <Enter> to continue.

Working with the SSU Interface

You can access features of the SSU interface using the mouse or keyboard:

e Mouse-Click once to choose menu items and buttons or to select items in a list, such as the
Available Tasks list. To run a list item, such as one of from the Available Tasks list, select the
item and click OK or double-click the item.

e Keyboard-Use the tab and arrow keys to highlight buttons and press the spacebar or <Enter>
to execute. You can also execute a menu or button by using the <Alt> key in combination with
the underlined letter in the name of the menu or button.

You can have more than one task open at the same time, although some tasks might require
complete control to avoid possible conflicts. The tasks achieve complete control by keeping the
task as the center of operation until you close the task window.

The SSU has a build-in help system, which you access by clicking a Help button or choosing the
Help menu.

Customizing the SSU Interface
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The SSU lets you customize your interface using the Preferences section of the main window. The
AF sets these preferences and saves them in the AF.INI file so that they take effect the next time
you start the SSU. There are four user customizable settings:
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e Color-lets you change the default colors associated with different items on the screen using
predefined color combinations. The color changes take effect immediately.

¢ Mode-lets you set the desired expertise level: novice, intermediate, or expert. The expertise
level determines which tasks are visible in the Available Tasks section and which actions each
task performs. For a new mode setting to take effect, you must exit the SSU and restart it.

e Language-lets you change the text in the SSU to the appropriate language. For a new language
setting to take effect, you must exit the SSU and restart it.

e Other-lets you show or hide the status bar at the bottom of the SSU main window. The change
takes effect immediately.

&> NOTE

If you run the SSU from read-only media (CD-ROM, for example), these
preferences are lost when you exit the SSU.

Exiting the SSU
Exiting the SSU closes all SSU windows.

Setting Boot Device Priority

To change the boot priority of a device:

1. From the SSU Main window, choose Boot Devices.
2. In the Multiboot Options Add-in window, select a device.

3. Click the Move Up button to move it up in the list. Click the Move Down button to move it
down.

Setting Passwords and Security Options

You can set a user password and an administrator password. On some systems, you must set an
administrator password before you can set a user password. On other systems, the passwords are
independent. You can set the same passwords and security options by using BIOS Setup.

Setting the Administrator Password

The Admin Password button lets you set or change the administrator password used by both the
SSU and the system BIOS. This option is not available if both an administrator and a user
password are set and you entered only the user password when you started the SSU. All changes to
the administrator password take effect immediately.

To change or clear the administrator password:

From the SSU Main window, choose Security.

Click the Admin Password button.

If you are changing passwords, enter the old password.

Enter the new password (or leave blank to clear).

Confirm the password by entering it again (or leave blank to clear).
Click OK to save the password and return to the Security window.

IO
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Setting the User Password

The User Password button lets you set or change the user password used by both the SSU and the
system BIOS. All changes to the user password take effect immediately.

To change or clear the user password:

SNk L=

From the SSU Main window, choose Security.

Click the User Password button.

If you are changing passwords, enter the old password in the first box.
Enter the new password (or leave blank to clear).

Confirm the password by entering it again (or leave blank to clear).
Click OK to save the password and return to the Security window.

Setting Security Options

For a description of security features, see “Security” on page 17.

To set the security options:

1.
2.

3.

In the Security window, click the Options button.

For each option, select the desired setting from the list. The options are:

e Security Hot Key: The key combination that can be used to put the server into secure
mode.

e Secure Mode Timer: If no keyboard or mouse activity occurs during the chosen time
interval, the server enters secure mode.

e Secure Mode Boot: Enable forces the server to boot directly into secure mode.

e Video Blanking: Enable turns off the video when the server is in secure mode.

e Floppy Write: Enable prevents writing to the diskette drive while the server is in secure
mode.

o Power Switch Inhibit: Enable prevents the power and reset buttons from functioning
when the server is in secure mode. Disable allows the power and reset buttons to function
normally when the server is in secure mode.

Click Save to save the settings and return to the Security window.

Viewing the System Event Log
To view the System Event Log (SEL):
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1.

From the SSU Main window, choose SEL. Manager.

When you start the SEL. Manager, it automatically loads the current list of events from non-
volatile memory.

Use the <F4> and <F5> keys to scroll the window contents to the left and right to view all of
the columns.

Intel Server Board SE7500WV2 Product Guide



Use the File and SEL menu items to work with the SEL information:

e Open: Views data from a previously saved SEL file.

e Save As: Saves the currently loaded SEL data to a file.

e Properties: Displays information about the SEL.

e C(Clear SEL: Clears the SEL data from the nonvolatile storage area.

e Reload: Refreshes the display by reading the current SEL entries from the server.

e Sort By: Sorts the displayed events by event number, time stamp, sensor type and number,
event description, or event generator 1D.

Viewing FRU Information
To view the Field Replaceable Unit (FRU) information:

1.

From the SSU Main window, choose FRU Manager.

When you start the FRU Manager, it automatically loads the current list of events from non-
volatile memory.

The FRU Manager window has a navigation pane on the left that displays, in a tree format, the
inventory of components in the server. The tree has three categories: Chassis, Board, and
Product. Clicking on a category expands or collapses a list of components for that category.
Clicking on an individual component displays the FRU information for that component in the
presentation pane in the upper right. The description pane in the lower right displays a
description of the currently selected FRU area.

Use the <F4> and <F5> keys to scroll the window contents to the left and right to view all of
the columns.

Use the File and FRU menu items to work with the FRU information:

e Open: Views data from a previously saved FRU file.

e Save As: Saves the currently loaded FRU data to a file.

e Properties: Displays the number of FRU devices in the system and the number being
displayed. Only FRU devices with valid FRU areas are displayed.

e Reload: Refreshes the display by reading the current FRU entries from the server.

Viewing Sensor Data Records
To view the Sensor Data Records (SDR):

1.

From the SSU Main window, choose SDR Manager.

When you start the SDR Manager, it automatically loads the SDR entries from non-volatile
memory.

The SDR Manager window has a navigation pane on the left that displays, in a tree format, the
sensor data records. The tree has categories for each type of record. Clicking on a category
expands or collapses a list of SDRs for that category. Clicking on an individual SDR displays
the information for that SDR in the presentation pane in the upper right. The description pane
in the lower right displays a description of the currently selected SDR type.

Use the <F4> and <F5> keys to scroll the window contents to the left and right to view all of
the columns.
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Use the File and SDR menu items to work with the SDR information:
e Open: Views data from a previously saved SDR file.
e Save As: Saves the currently loaded SDR data to a file.

e Properties: Displays information about the SDR, including IPMI version, number of SDR
entries, time stamps for changes to the SDR information, and free space remaining.

e Reload: Refreshes the display by reading the SDR data from the server.

Updating System Firmware and BIOS

Using the SSU, you can update the BIOS, update the firmware, and verify the firmware.
Procedures for each are given below. You can also update the BIOS and firmware without using
the SSU (You can download the updates from the Intel support website:

http://support.intel.com/support/motherboards/server

Updating the BIOS

To update the BIOS:

1. Download the update from the Intel support website.

2. From the SSU Main window, choose System Update. (System Update is available only in
Expert mode.)
When you start System Update, it automatically displays the current revision information for
the system firmware and BIOS.

3. From the File menu, choose Load and choose a .uif or .bio file to use for the update.

4. Click the Update button to update the BIOS.

Updating the Firmware

To update the system firmware:

1.
2.

3.
4.

Download the update from the Intel support website.

From the SSU Main window, choose System Update. (System Update is available only in
Expert mode.)

When you start System Update, it automatically displays the current revision information for
the system firmware and BIOS.

From the File menu, choose Load and choose a .uif or .hex file to use for the update.

Click the Update button to perform the update.

Verifying the Firmware

To compare the system firmware in nonvolatile memory with a firmware file:
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1.
2.

Download the update from the Intel support website.

From the SSU Main window, choose System Update. (System Update is available only in
Expert mode.)

When you start System Update, it automatically displays the current revision information for
the system firmware and BIOS.

From the File menu, choose Load and choose a .hex file to use for the update.

Click the Verify button to compare the firmware code in nonvolatile storage with the selected
file.
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Saving and Restoring the System Configuration

Using the SSU, you can save the following configuration information to a file:

e Platform type, BIOS revision, and firmware revision

e CMOS settings

e Extended system configuration data (ESCD)

e Settings for the emergency management port (EMP), platform event paging (PEP), and BMC
LAN alerts

Data is saved from all sources. There is no way to choose only certain pieces of configuration data
to save. You can also restore the information from a saved configuration file.

&> NOTE

BIOS passwords are stored in the file. Restoring a configuration can change
passwords on a server. EMP and LAN passwords are not stored in the file.

Saving a Configuration
To save the system configuration:
1. From the SSU Main window, choose Config Save/Restore. (Configuration Save/Restore is

available only in Expert mode.)
2. Click Save To File and specify a filename and location.

Restoring a Configuration

To restore the system configuration from a file:

1. From the SSU Main window, choose Config Save/Restore. (Configuration Save/Restore is
available only in Expert mode.)

2. Click Restore from File and specify a filename and location.
The CSR reads the platform type, BIOS revision, and firmware revision from the file and
compares that information with the same information retrieved from the server. If the two do
not match, an error message is displayed and the restore operation aborts. If they do match, the
CSR restores the configuration data to the server. It prompts you to reboot the server for the
new settings to take effect.

Alerting for Platform Events

You can set up the server to alert you when various events occur. Alerts can be delivered either as
telephone pages or over the LAN. Instructions for setting up both telephone paging alerts and LAN
alerts are given below.

Setting Up Paging Alerts
To set up the server to send alerts as telephone pages:

1. Install an external modem on the Emergency Management Port (serial 2).
2. From the SSU Main window, choose Platform Event Manager (PEM).
3. In the PEM window, click Configure EMP.
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10.

11.
12.

13.
14.
15.

16.
17.

52

In the corresponding boxes, enter the following command strings for the modem attached to the

EMP port (boxes that aren’t listed here are not required for paging alerts):

e ESC Sequence: the escape sequence. This string is sent to the modem before sending
command strings. The maximum length for the string is five characters; longer strings are
truncated.

e Hangup String: hang up or drop the connection. The EMP automatically sends an
<ENTER> character following this string. The maximum length for the string is eight
characters; longer strings are truncated.

e Modem Dial Command: the command to dial a phone number. This string is sent to the
modem before sending the paging string.

e  Modem Init String: the initialization string for the modem. This string is sent every time
the EMP initializes. The maximum length for the string is determined at run-time from
firmware. You will be notified if the string is truncated. Following a save, the actual string
saved is displayed in the edit box.

Click Save to save the changes.

Click Close to return to the PEM window.

In the PEM window, click Configure PEP.

Select the Enable PEP check box.

In the Blackout Period box, enter the minimum time, in minutes, between successive pages.

The valid range is [0 - 255] where 0 disables the blackout period. Setting a blackout period can

save you from being flooded with repeat pages. After you receive a PEP page, no additional

pages are sent by PEP for the duration of the blackout period.

In the Paging String box, enter the phone number to dial for the page and the message you want

sent with the page. The maximum length for the paging string is determined at run-time from

firmware. You will be notified if the string is truncated. Following a save, the actual string
saved is displayed in the edit box.

From the Options menu, choose Configure Event Actions.

In the Platform Event Paging Actions window, move the events that you want to generate an

alert to the Enabled column and move all other events to the disabled column using the

following buttons:

e >>: Moves all events from the enabled list to the disabled list.

e >: Moves the selected event from the enabled list to the disabled list.

e < Moves the selected event from the disabled list to enabled the list.

e <<: Moves all events from the disabled list to the enabled list.

Click Save to save the changes.

Click Close to return to the PEP Configuration window.

To send a test page to verify that you have correctly configured PEP, from the Options menu,
choose Send Alert.

Click Save to save the configuration.

Click Close to return to the Platform Event Manager window.
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Setting Up LAN Alerts

To set up the server to send alerts over the LAN:

1.

10.

11.
12.
13.

14.
15.

Configure the remote system to receive alerts. For more information, see the documentation

for Intel Server Management software.

From the SSU Main window, choose Platform Event Manager (PEM).

In the PEM window, click Configure LAN and fill in the boxes described in the following steps

(boxes that aren’t listed here are not required for LAN alerts).

Select the Enable LAN Alerts check box.

(Optional) In the SNMP Community String box, enter a string for the community field in the

Header section of the SNMP trap sent for an alert. The string must be from 5 to 16 characters.

The default string is public.

In the IP Setup box, choose either:

e DHCP: the IP address for the server is automatically assigned by the DHCP (dynamic host
control protocol) server on the network. The Host, Gateway, and Subnet Mask boxes in the
dialog are ignored.

e Static: assign the IP address for the server using the Host, Gateway, and Subnet Mask
boxes in the dialog.

If you chose Static IP Setup in the previous step, fill in the IP addressing boxes:

e Host IP Address: the IP address of this server.

o Gateway IP Address: the IP address of the router for this server.

e  Subnet Mask: the IP address for the server’s subnet. The server uses this to decide if the
alert destination is on the same subnet.

In the Alert IP Address box, fill in the IP address of the system you want to receive alerts from

this server. If you want the alert to be broadcast to an entire subnet, enter the IP address for the

subnet.

From the Options menu, choose Configure Event Actions.

In the BMC LAN Alerting Actions window, move the events that you want to generate an alert

to the Enabled column and move all other events to the disabled column using the following

buttons:

e >>: Moves all events from the enabled list to the disabled list.

e >: Moves the selected event from the enabled list to the disabled list.

e < Moves the selected event from the disabled list to enabled the list.

e <<: Moves all events from the disabled list to the enabled list.

Click Save to save the changes.

Click Close to return to the BMC LAN Configuration window.

To send a test alert to verify that you have correctly configured BMC LAN alerts, from the

Options menu, choose Send Alert.

Click Save to save the changes.

Click Close to return to the PEM window.
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Managing the Server Remotely

You can set up the server so that you can connect to it from a remote client system to perform
management tasks. You can make the connection over a LAN or by using a modem or direct serial
cable to the Emergency Management Port (EMP). Instructions for setting up the server for remote
LAN and serial/modem access are given below.

Setting Up Remote LAN Access

To configure remote LAN access:

1.
2.

7.
8.

From the SSU Main window, choose Platform Event Manager (PEM).

In the PEM window, click Configure LAN and fill in the boxes described in the following steps

(boxes that aren’t listed here are not required for remote access).

To require a password for remote access, enter the password in the Enter New Password box

and in the Verify New Password box. Passwords can be from 1 to 16 characters long, using

any ASCII character in the range [32-126]. To clear the passwords, leave both boxes blank.

(You can also clear the password by choose the menu Options > Clear LAN Password.)

From the LAN Access Mode list, select the remote access mode:

e Full Access: aremote system can initiate a LAN connection regardless of the state or
health of the server.

e Restricted: aremote system can initiate a LAN connection, but cannot perform control
operations such as power down, reset, or front panel NMI.

e Disabled: remote systems are not allowed to initiate LAN connections.

In the IP Setup box, choose either:

e DHCP: the IP address for the server is automatically assigned by the DHCP (dynamic host
control protocol) server on the network. The Host, Gateway, and Subnet Mask boxes in the
dialog are ignored.

e Static: assign the IP address for the server using the Host, Gateway, and Subnet Mask
boxes in the dialog.

If you chose Static IP Setup in the previous step, fill in the IP addressing boxes:

e Host IP Address: the IP address of this server.

e Gateway IP Address: the IP address of the router for this server.

e Subnet Mask: the IP address for the server’s subnet. The server uses this to decide if the
alert destination is on the same subnet.

Click Save to save the changes.

Click Close to return to the PEM window.

Setting Up Remote Modem or Serial Access

To configure remote modem or serial access:

1.
2.
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From the SSU Main window, choose Platform Event Manager (PEM).
In the PEM window, click Configure EMP and fill in the boxes described in the following steps
(boxes that aren’t listed here are not required for remote access).
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3. To require a password for remote access, enter the password in the Enter New Password box
and in the Verify New Password box. Passwords can be from 1 to 16 characters long, using
any ASCII character in the range [32-126]. To clear the passwords, leave both boxes blank.
(You can also clear the password by choose the menu Options > Clear LAN Password.)

4. Inthe Modem Ring Time box, enter the number of 500ms intervals that the BMC should wait
before taking control of the ser